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CV5454-L-P    In every rail Building Information Modeling (BIM) design that you do, you need the most 

effective options to help you make the right decision. InfraWorks software can help you do this. With the 
software’s capacity to analyze many scenarios, you can make several proposals and choose the most 
effective one to fulfill the basic premises of the project, and you can show these proposals in an easy 
way to all stakeholders. Then, you can use the Rail Layout Module in AutoCAD Civil 3D software to 
design the whole railway, its details, and analyze it. With all the analysis done, you can generate reports 
and the final documentation thus, delivering the most effective rail project you have ever created. 

Learning Objectives 

At the end of this class, you will be able to: 

 Know how to develop rail design using Infrastructure Design Suite software 

 Know about integration with many software systems to make a great rail project 

 Know how to make a presentation to show your rail project in a simple way 

 Know how to generate the documentation to deliver your rail project. 

 

 

 

About the Speaker 

Pedro Luis Soethe Cursino is a civil engineer and technical specialist with Infrastructure Brazil. 

He has worked in the infrastructure industry for the past 18 years, and he specializes in 

highway projects. Pedro has been using AutoCAD Civil 3D software for 7 years and the 

industry-specific AutoCAD software products for over 15 years. Pedro is an AutoCAD Civil 3D 

Certified Professional. He has presented at Autodesk University 2012, 2013 and 2014 in Brazil 

and at Autodesk Infrastructure Symposium in 2013 in Vegas. His vast experience includes real-

world application of InfraWorks and AutoCAD Civil 3D software in the engineering, natural 

resources, and infrastructure (ENI) industry, as well as in mapping and infrastructure. He 

enjoys teaching and specializes in relating to class participants and helping them to get the 

most out of training courses. 
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The structure of the class. 
 The class is about a connection between a Logistic Center Company and a Main Rail 

Course in Brazil.  

 

 The map above shows the location of the new Logistic Center Company and the Main Rail 

Course. We need to connect the LCC to the MRC.  

 We divided the design in two parts. One of them is the preliminary design, which we will 

do in InfraWorks 360. The other is the design detailing which we will do in AutoCAD Civil 3D. 

   We recorded the whole process and posted it at https://screencast.autodesk.com under 

the class code CV5454-L-P. 

 We will be referencing the videos in class and throughout this handout.  

 We separated the data sets for each part into different folders. For example, if you want 

to start from the AutoCAD Civil 3D part it’s ok - just start from folder “04 – AutoCAD Civil 3D 

Step 01”. This data set and the others are in the DataSet folder, in our class folder at the AU 

Las Vegas site. 

 Let’s say we were starting from InfraWorks 360. 

 

 

    

Location of Logistic 

Center Company 

Main Rail Course 

São Paulo 

Rio de Janeiro 

https://screencast.autodesk.com/
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Using InfraWorks 360 to create a good preliminary design. 
 

 We will be using the InfraWorks 360 to create a preliminary idea of what we want. This 

software will help you deliver a great presentation and generate a clear display of all the all 

variables involved in the design. 

 In our class, we will be designing a connection between a new logistic center company, 

further on referred to as LCC, to the main rail course, further on referred to as MRC, which 

connects the main cities in Brazil. 

 The owner of the LCC and the company that manages the MRC need to approve the 

preliminary design before releasing the final stage of the design. The best way to do this is through 

InfraWorks 360. 

Starting the Project by creating the Model. 

 

 The first thing we need to do is obtain the bases for our project. The bases are survey 

data such as terrain elevation and the all information we need to make the project. 

 To do this we need to contract a surveyor to collect all the land data. In our particular case, 

the area, which we would need to survey, is too large, since we do not yet know exactly where 

the new railway will pass between the LCC and the MRC. Collecting data from an area that large 

is too expensive. 

 Fortunately, we have a way to do this free, the only thing you need is InfraWorks 360. 

InfraWorks 360 has an excellent tool that can obtain all the data you need in simple way. This tool 

is a Preview tool. Obtaining the model from this tool is very simple. Just follow these few steps. 

1. The first thing you have to do is launch InfraWorks 360. Click on “Model Builder” as shown 

in the figure below. 
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2. The Model Builder (Preview) will appear. In the top, we have a search box. There, enter 

the name of the project location. In this case, it is “Taubate, Brazil” as show in the figure 

below. 

 

 
 

 

3. After some time, the location will appear on the right side where the map is located. Try to 

find the area showed in the figure below. 

 
 

4. After you find the location, enter the name of the model in the box marked in the figure 

above. In our case, I entered the name “Rail Connection”. After you enter the name click 

on button Create Model  
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5. A message will appear informing that the model will be finished in 10 to 15 minutes, and 
as soon as finished you will receive an e-mail. 

6. Wait for the e-mail such as the figure below informing you the model has been created 
and is ready for use. 

 

7. Go back to InfraWorks 360. Click on the Refresh button and the model will appear under 

the Online Models section. Select the model and download it. 

 

  
 

8. The model will open and appear on your screen. 
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9. If you feel that you have missed anything, I recommend that you open these two videos. 

They explain the process up until now. 

 

01 - InfraWorks 360 - Creating a Model from Model Builder - CV5454-L-P 

https://screencast.autodesk.com/Main/Details/2ec43346-2cd8-477d-9a28-d4ac2ed6783f 

 

02 - InfraWorks360 - Importing and Opening the Model - CV5454-L-P 

https://screencast.autodesk.com/Main/Details/ff3ca72c-9cdb-4093-8612-c027ddd59e82 

 

 

 

  

https://screencast.autodesk.com/Main/Details/2ec43346-2cd8-477d-9a28-d4ac2ed6783f
https://screencast.autodesk.com/Main/Details/ff3ca72c-9cdb-4093-8612-c027ddd59e82
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Starting in InfraWorks 360 

 

Opening the Model 

If you have decided to start from here, we will be opening the finished model. It is located in the 

DataSet folder called “1-InfraWorksModel” under the name RailConnection.sqlite. Follow these 

few steps to open the model in InfraWorks. 

1. Select Open. 

 
 

2. After that, the Open dialog box will appear. Find the RailConnection.sqlite file and select 

the Open button. 

3. The model will appear in the InfraWorks. 

 

Some useful information about the InfraWorks 360. 

Now, we will discuss a bit more about the InfraWorks 360. This product is relatively new. 

This particular release of InfraWorks launched this year (2014).  

The first thing to know is about its workspace. InfraWorks 360 has a unique workspace 

different from any Autodesk product. 
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The figure above show us the workspace of InfraWorks 360 

1 - In box number one, we have the modules of InfraWorks. These modules enable us to 

design roads, buildings, city furniture, covered areas, bridges, drainage systems and so forth.  

With these modules, we can design, evaluate, and perform analysis, quantifications and 

especial visualizations, renders and animations. 

 

Roadway Module to 

design and evaluate 

roads

Drainage Module to 

design and evaluate 

drainage systems.

Bridge Module to 

design and evaluate 

bridges

Construction Module to 

build, manage and 

analyze the model.

Presentation Module to 

create and conduct 

infrastructure design 

presentations

Settings and Utilities

Back to 

Home 

screen

Options
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2 – Box number two is where the different proposals for your design are stored.  

3 – In box number three, we have some commands to manipulate the model. 

 

 

 

 

 

 

4 - Box number four contains the gizmo to set visualizations modes. 

The final thing is how the mouse controllers behave. It is very similar to Google Earth 

controllers. 

 

 

 

 

 

Full screen mode

Redo

Properties

Bookmark 

current 

visualization

Undo

Edit mode

Selection mode

Help

Left-click and drag  

the mouse in the  

desired direction

Right-click is 

similar to PAN 

in AutoCAD.

Scroll button is 

for zooming in 

and out
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Working with proposals  

One of the greatest features of InfraWorks is the chance 

to work with multiple proposals.  

How did I make these proposals? 

 It is very simple to create new proposals. Follow 

these steps to setup more than one proposal. 

1. For starters, you are in the Master proposal. 

Select the arrow beside “master”. 

 

2. Select Create new proposal 

 

 
 

3. Give a name to this new proposal. 

 
 

4. Click OK, and you are all set. You have successfully created a proposal based on the 

previously selected proposal. 

5. To alternate between proposals, reopen the proposal menu and choose another 

proposal. 

 

 

Cool Tip: When you create a 

new proposal, all of the 

elements in the currently 

selected proposal go to the new 

proposal. The MASTER 

proposal is the original model; 

we strongly recommend that 

you do not use this MASTER 

proposal for anything! Before 

you start creating a different 

situation, save a new proposal 

from the MASTER proposal. 
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6. If you feel that you have missed anything, I recommend that you open this video. It 

explains this process. 

03 - InfraWorks 360 - Creating Proposals - AU CLASS - CV5454-L-P 

https://screencast.autodesk.com/Main/Details/2ec43346-2cd8-477d-9a28-d4ac2ed6783f 

 

Starting to create ideas 

 After creating the new proposal, we will start by creating two separate options.  

To create these options we have two different ways. One of them is using the Railways 

command, but in doing so, we are not able to export the Alignment to AutoCAD Civil 3D. 

However, we do have some great workarounds.  

Using the Railway command 

Let’s get started. All we need to do is follow the next steps. 

1. Make sure you are in the Proposal Number 01  

2. The first thing we have to do is access the construction menu and then select the icon 

Railway, or Add Railways to your conceptual design, as shown below. 

 
 

3. Now choose the Railway Style. 

https://screencast.autodesk.com/Main/Details/2ec43346-2cd8-477d-9a28-d4ac2ed6783f
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4. After that, the only thing you need to do is to click on the model and try to find the best 

design. 

5. If you feel that you have missed anything, I recommend that you open this video. It 

explains this process. 

04 - InfraWorks 360 - Creating The First Idea - AU CLASS - CV5454-L-P 

https://screencast.autodesk.com/Main/Details/2ec43346-2cd8-477d-9a28-d4ac2ed6783f 

Change the Railway style. 

After creating the railway, we can make changes in the Railway style. To do this follow 

the next steps. 

1. In the construction menu, look for the Style Palette. 

 

 
 

2. After that, find the Railway tab. 

  
 

3. Double click on the style. 

 

https://screencast.autodesk.com/Main/Details/2ec43346-2cd8-477d-9a28-d4ac2ed6783f
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4. The Configure Railway dialog box appears. There we can make several changes 

like structural options and materials. Let’s try to change the Gauge to 6.50ft.  

 

 

5. After doing so, this icon will automatically appear     in front of Flange and 

Gauge. This icon means that now the sleeper is smaller than Gauge+Flange. 

Therefore, we need to change the Sleeper. 

 

6. Click on Sleeper Settings and then in Width change to 8.000ft. You will see that 

after that, the preview image will appear again. 
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7. Click on OK, and the model will be updated automatically. 

8. If you feel that you have missed anything, I recommend that you open this video. 

It explains this process. 

05 - InfraWorks 360 - Changing Styles - AU CLASS - CV5454-L-P 

https://screencast.autodesk.com/main/details/2ca7fa42-6db0-4181-a94e-

d19681269cc5 

Modifying the Railway geometry. 

 You can modify the geometry already made. To do so, follow the next steps. 

1. Select the Edit Mode. 

 
 

2. After that, select the Rail that was created. 

3. Notice the grips appear 

  

Importing the new Railway style as a Roadway. 

Now we will start doing the same thing but using a Railway as a Roadway, and with that 

exploring new possibilities, like defining curve radii, profile, and more. To do this we need to 

import a style from the Data Set files. To do this follow the next steps. 

1. Open the Style Palette. 

Change the elevation

Change the position

https://screencast.autodesk.com/main/details/2ca7fa42-6db0-4181-a94e-d19681269cc5
https://screencast.autodesk.com/main/details/2ca7fa42-6db0-4181-a94e-d19681269cc5
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2. In the Style Palette go to the Road tab.  

3. Now we are going to import the Style clicking on the button as show bellow.

 
4. In the DataSet folder called 2-RailStyle select the RailRoadPedro.styles.json. 

5. The new Style will appear named RailWays 
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6. After that, we can use this new style in our project. 
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Cool Tip: If you have not created 

the new proposal yet, change first 

to Master and then create the new 

proposal, if you will create the 

new proposal under another 

proposal everything from this 

proposal goes to the new one. 

Creating the second idea. 

Much like the first idea, we will create a new option, but now using the Style we 

imported. 

The first thing we have to do is change the Proposal to RailProposal02 

 
 

Now follow the next steps. 

 

1. Go to Create Local Road in the Roadway Module, as pictured below. 

 
2. The dialog box named Select Draw Style will appear, and then we must choose 

the Railway Style. To find it more quickly, type railway at the top of the dialog 

box, as shown below. 
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3. Select the RailWays style. 

4. After that you can create the new proposal. 

5. Notice that we now have a chance to choose the speed. 

 
The speed changes the minimum radius based on the AASHTO. 

6. Design the proposal. 
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Modifying the Railway geometry. 

 You can modify the geometry already made. To do so, follow the next steps. 

1. Select the Edit Mode 

 
 

2. After that select the Rail that was created. 

3. Notice the grips appear 

  
4. We can modify the radius of the curve just by clicking on the curve with the right button 

of the mouse. In addition to that, you can change its size typing the new radius. 

 
 

5. If you want to change the Elevation you can do so by altering the Profile. Click on Profile 

View, as shown below. 

Change the radius 

Change the position
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6. The profile will appear at the bottom. After that, you can modify the PVIs and those 

changes will automatically appear in our model. If you change the view, you can make 

changes directly to the model, and those will appear in the profile view. 

 
 

 

Change the position
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7. We can make many other types of changes, and we show you how to do so in the 

following video, along with all that we have done up until now. 

06 - InfraWorks 360 - Creating a new Proposal with Roadway Module - AU CLASS - 

CV5454-L-P 

https://screencast.autodesk.com/Main/Details/81c021eb-ba64-410b-88cd-fa8d46c2180d 

 

Creating a Visualization 

To create a proper visualization in InfraWorks, there are some awesome possibilities. 

Let’s take a look at some of them.  

 

1. Set your model to show the portion you want InfraWorks to render. 

2. Access the Visualization Menu and then select Render Model, as pictured below. 

 

https://screencast.autodesk.com/Main/Details/81c021eb-ba64-410b-88cd-fa8d46c2180d
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3. After you click on the Render Model button, the render automatically begins, so when 

you think the visualization is ok, select the Stop button . 

4. After doing so, select Save. 

 
 

Another way to show your project idea to others is by creating an animation.  

 

1. Access the Visualization Menu and then select the Storyboard Creator button. 
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2. A dialog box named Storyboard will appear at the bottom of your model. Click on the 

Add Camera Path Animations button and then select the option Create from Design 

Road. 

 
3. Click on the Railway and press Enter.  

4. After that, the resulting animation will appear, frame by frame, in the storyboard.  

 

5. If you want to see the results, click on the play button . 

 

6. You can Export the animation by clicking on the recorder . 
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Exporting to AutoCAD Civil 3D 

After you have decided on your project alternative in InfraWorks, it’s time to advance in our 

Design, and we can do so with AutoCAD Civil 3D. We can export what we have done up until 

now in InfraWorks to AutoCAD Civil 3D, by following the next steps. 

1. In the Settings menu select the Export IMX button. 

 
 

2. In the Export IMX dialog box, beside Define Interactively, select the downwards arrow 

and choose the option BBox. 
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3. Select the area which we want to export, as shown below 

 
 

4. Select the folder where you want to save the IMX. 
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5. Click on Export. 

6. To see the visualization part, as well as the part in which we export to AutoCAD Civil 3D, 

access the video bellow. 

07 - InfraWorks 360 - Creating a new Proposal with Roadway Module - AU CLASS - 

CV5454-L-P 

https://screencast.autodesk.com/Main/Details/81c021eb-ba64-410b-88cd-fa8d46c2180d 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://screencast.autodesk.com/Main/Details/81c021eb-ba64-410b-88cd-fa8d46c2180d
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Developing the project with AutoCAD Civil 3D 
 

Now we are developing the project inside the AutoCAD Civil 3D. 

Importing to AutoCAD Civil 3D 

The first thing we must do is open the AutoCAD Civil 3D. After that, just follow the next few 

steps. 

1. In the start screen click to Start Drawing with _AutoCAD Civil3D (Metric) NCS.dwt 

 

2. Now, go to the Insert tab on the Ribbon, and select Import IMX 
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3. In our DataSet folder named 3-IMXFile, search for a file called RailCivil.imx and select 

Open. 

 
 

4. After doing so, all the information created with Autodesk InfraWorks is imported to 

Autodesk Civil 3D. 
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Creating the connection with Rail Layout Module 

Now let’s create a turnout to connect the Main Course to the new course. For this we will 

be using the Rail Layout Module. This application is available through Autodesk Subscription. 

In this part, we will use the file named RailDesign.dwg, which is located in the DataSet 

folder called 4-AutoCAD Civil 3D File. 

To create the turnout, just follow the next few steps. 

1. In the Toolspace, click on the Toolbox tab. Then click to expand the Subscription 

Extension Manager. The Autodesk Rail Layout Module will appear, as shown below. 

 

2. Expand the Autodesk Rail Layout Module and right click the item Rail Turnout 

Catalog. Select Execute. The Turnout catalogue dialog box will appear. In this dialog 

box, complete the following tasks, as pictured below: 

a. Change the “R” to 400.00m (minimum radius) 

b. Change the “d” variable to 40.00m 

c. Change the Name to 400-1:9 

d. Click on the Add  button 

e. Click OK to close the Turnout catalogue dialog box.  
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3. Again, in the Toolspace, below Autodesk Rail Layout Module, right click Create Rail 

Turnout and then select Execute. 

 
4. The dialog box Draw Turnout will appear. In this dialog box, set the following fields, 

as pictured below: 

 

a. Select axis – RailMainCourse 

b. Type – Straight-Line Switch 

c. Name – 400-1:9 49 

d. Insertion point – Beginning (1) 

e. Turnout – Left 

f. Direction – Backward 
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g. Turnout axis name: RailConnection 

h. GM(m): 3.50 

 
 

5. After that, we need to place the turnout in the drawing. To do this select the Place 

button, and insert the turnout in the drawing. 

6. If you already know the station where the turnout should be allocated, you can just 

type in the station in the Station (m) field. 

 
 

7. Now, select OK and the Turnout will be added to the design, as shown below. 
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Change the type of Alignment and add Design Criteria 

 Now, we need to adjust the RailConnection alignment with the Turnout and check if the 

radii of the design are OK by setting Design Criteria. 

 The first thing we need to do is transform the Alignment into a Rail Alignment, to enable 

several things such as special Criteria Design and Cant calculations. To do so, follow the next 

steps. 

1. Select the Alignment. Right click the Alignment and select Alignment Properties. 

 
2. In the Alignment Properties dialog box, change the Type from Centerline to Rail. 
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3. After that, a new tab will appear, after Design Criteria. The new tab is called Rail 

Parameters. Select that tab, and change Track Width to 1.500m. 

 

4. Now, select the Design Criteria tab. Click on the Add Design Speeds button  and 

change the Design Speed to 40km/h. 

5. Check the selection box Use criteria-based design. Click on the Select File button  

and select the file _Autodesk Civil 3D Metric Rail Cant Design Standards.xml. 
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5. Change the Minimum Radius to Applied Cant by Formula 0.64 

Adjusting the Alignment to the Turnout  

 We will now adjust the alignment using Design Criteria and connect the Turnout. To do 

this, follow the next steps. 

1. The first thing to do is connect the Alignment with the Turnout.    
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2. Then, we have to adjust the Turnout curve by adding a radius to this new PI so that it fits 

in with the rest.  Click on the alignment RailConnection and then select the Geometry 

Editor button. 

 

 

 

3. After that, click to add a Curve-Spiral and select Free Spiral-Curve-Spiral (Between two 

entities), as shown below. 

 

  
 

4. Now, add the curve to the PI. 

a. Choose the option LessThan180 

b. Use the minimum Radius 350.00m 

c. Input 50.00m to the Spiral on both sides. 

 
 

5. Do this to all of the curves to adjust the Radius and the Spiral. In doing so, all of the 

entities will be compatible to the Design Criteria. 

6. To see the importing to AutoCAD Civil 3D part, as well as the part in which we add the 

Turnout and adjust the alignment with Design Criteria, access the video below. 
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08 – AutoCAD Civil 3D – Importing and Adjusting Alignment with Turnout - AU CLASS - 

CV5454-L-P 

https://screencast.autodesk.com/Main/Details/c2d95b1d-265d-47f6-a3e6-44f960a0ae03 

Creating the Profile  

 Now, we will create the Profile of the new RailConnection.  

In this part we are using the file RailDesign-Turnout.dwg in DataSet folder 5-AutoCAD 

Civil 3D File - AfterTurnout. 

The profile already came from InfraWorks but we need to make some adjustments. To 

do so, just follow the next few steps. 

1. Click on the Home tab in the Ribbon. Select Profile View and then choose the 

option Create Profile View. 

 

2. The Create Profile View toolbox will appear. Just select Create Profile View. 

3. Select a place in the drawing to add the profile view. 

 

https://screencast.autodesk.com/Main/Details/c2d95b1d-265d-47f6-a3e6-44f960a0ae03
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4. In this case we are using the Grade maximum of 1.00% and the Curve Length 

minimum of 60.00m. 

5. The first thing we need to do is move the end of the project grade to end of the 

existing ground. 

 

 
 

6. With the final ground profile selected, select the Geometry Editor button  

7. Then, click on the Profile Grid View button  

8. Now, adjust all of the Grade Out to a minimum of 1.00% 

9. Adjust the Profile Curve Length to a minimum of 60.00m. 

 
10. Feel free to adjust other grade values. 
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Creating the Assembly 

 Now, we will create the Assembly of this new Rail Connection. To do this, just 

follow the next few steps. 

1. Select the Home tab in the Ribbon. Click on Assembly and the choose Create 

Assembly, as shown below. 

 
 

2. The Create Assembly dialog box will appear. In this dialog box change: 

a. The name to RailConnection  

b. The assembly type to Railway 

c. Code set style to Basic 

 
d. Click OK. 

3. Select a clear spot in the drawing area. 
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4. Now, in the Home tab of the Ribbon, select the Tool Palettes button.  

 
5. Select the Bridge and Rail tab. 
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6. Then, select the subassembly named RailSingle and insert it in the center of the 

Assembly. 

 

7. Select the RailSingle subassembly and in the Ribbon select the Subassembly 

Properties button, as shown below. 

 
8. The Subassembly Properties dialog box will appear. Select the Parameters tab. 
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9. Here we can change many parameters within the subassembly geometry 

properties. 

 
10. Change the Gauge Width to 1.50m and click OK. 

11. Now, we must add a Daylight subassembly to both sides of the rail. Return to the 

Tool Palettes and select the Daylight tab. Click on the subassembly named 

Daylight General and insert it on the right side of the RailSingle subassembly. 
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12. Select the DaylightGeneral subassembly and click on the Subassembly 

Properties button. 

 
 

13. The Subassembly Properties dialog box will appear. Select the Parameters tab. 

Configure the parameters’ input values as follows: 

a. Flat Cut Slope – 1.00:1 

b. Medium Cut Slope – 1.00:1 

c. Steep Cut Slope – 1.00:1 

 

  
d. Flat Fill Slope – 1.50:1 

e. Medium Fill Slope – 1.50:1 

f. Steep Fill Slope – 1.50:1 

g. Click OK 

 

 
 

14. After that, right click the DaylightGeneral subassembly select the option Mirror. 
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15. Now, click on the end of the left side of the RailSingle subassembly. 

 

Calculation of Cant 

Now, we will calculate the superelevation of the Railway, known as Cant. 

 

1. Select the RailConnection alignment. Then, in the Ribbon, click on the Cant 

button, and select Calculate/Edit Cant. 
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2. Click on the Calculate Cant Now button. 

3. In the Calculate Cant - Railway Type dialog box change the Pivot Method to 

Center Baseline. 

 

4. Click on the Next button 

5. The only default we must change here is to mark the selection box Automatically 

Resolve Overlap, as shown below. 

 

6. Click on the Finish button. 

7. Check the Cant Tabular Editor to see the results of the Cant calculation. 
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Adding Labels to the Alignment 

1. Right click the RailConnection alignment and select Edit Alignment Labels. 
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2. In the Alignment Labels dialog box, in Type, choose the Cant Critical Points. 

 

3. Then, click Add >>. 

 

4. Click OK. 

5. Click OK again. 
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Creating the Corridor 

 Now we will combine the Alignment with the Profile and the Assembly in one 

single element called Corridor. To do this, just follow the next few steps. 

1. Select the Home tab in the Ribbon, and click on the Corridor button. 

  
 

2. After that, the Create Corridor dialog box will appear. Set the following fields: 

a. Name – RailConnection 

b. Assembly – RailConnection 

c. Target Surface – AIM_Surface_Ground 

d. Click OK. 

3. The Baseline and Region Parameters dialog box will appear. The only default we 

must change is the Frequency. To do so, click on the Set all Frequencies button. 
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4. In the dialog box, set the following values:  

a. Alignment Tangents – 10.00m 

b. Curve Increment – 5.00m 

c. Along Spirals – 5.00m 

d. Click OK. 

 
 

5. Click OK again to process the Corridor. 

6. Select Rebuild the Corridor. 

7. We now have successfully established the Corridor in the Drawing. 
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Creating the Corridor Surface 

 We must now create the Surface of the Corridor. 

1. Select Corridor and in Corridor Properties button. 

 
2. The Corridor Properties dialog box will appear. Select the Surfaces tab. 

3. Click on the Create a corridor surface button, as shown below. 

 
 

4. Under Specify code, select Datum. Then, click on the Add button. 
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5. Change the Overhang Correction from None to Bottom Links. 

 

6. Select the Boundaries tab. 

7. Right click the RailConnection and choose the option Corridor extents as outer 

boundary, as shown below. 

 

8. Click OK and then select Rebuild the Corridor. 

Creating Sections 

 We must now create the Sections, to check if everything turned out as expected. 

1. Select the Home tab, in the Ribbon. Click on the Sample Line button. 

 
 

2. Hit Enter and then choose the RailConnection alignment in the Select Alignment 

dialog box. 

3. Set the dialog box fields as follows:  

a. Name – RailConnection 

b. Style of Corridor Surface –  Finished Ground (as pictured below) 
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4. Click OK.  

5. The Sample Line Tools dialog box will appear. Expand the Sample Line Creation 

Methods, and select the option By Range of Stations…, as shown below. 

 

 

6. Change the following aspects to match the image below. 

a. Increment Along Tangents – 10.000m 

b. Increment Along Curves – 10.000m 

c. Increment Along Spirals – 10.000m 

d. True for all the options in Additional Sample Controls. 
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7. Click OK. 

8. Hit Enter. 

 

Showing the Sections. 

1. Select the Home tab in the Ribbon. Click on the Section Views button and then 

select Create Multiple Views.  

 
 

2. In the Create Multiple Section Views dialog box, select Create Section Views, 

and select a clear spot in the drawing area. 
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Volume Calculation 

1. To calculate the Volume select the Analysis tab of the Ribbon. Then, click on the 

Compute Materials button, as shown below. 

 

2. Click OK to confirm. The Compute Materials dialog box will appear. 

3. Under Surfaces, in EG, Click here to set all, select the AIM_Existing_Ground. 

4. In DATUM, in Click Here to set all, select the RailConnection. 
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5. Click OK. 

6. Now, select Total Volume Table, as shown below. 

 

7. Confirm the options and click OK. 

8. Select a clear spot in the drawing area. 

9. To see the profile part, as well as the part in which we create the sections, 

calculation of cant and volumes, access the video bellow. 

09 – AutoCAD Civil 3D – Create a Final Design - AU CLASS - CV5454-L-P 

https://screencast.autodesk.com/Main/Details/2df3b8ee-47dd-4628-b213-

1409776300ef 
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